Exploring Derwent World Patents Index® in STN® AnaVist™, Version 2.0

Robert Austin – FIZ Karlsruhe
Agenda

- Getting started with STN AnaVist 2.0
- Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0
- A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0
- Project sharing and pricing structure
Increasingly, Information Professionals are required to do more than locate documents:

- **Analyze the patent landscape**
  - Determine who, what, where, when, and why
- **Track competitive intelligence**
  - Find out what your competitors are doing
- **Discover new applications for existing technology**
- **Determine research trends**
  - Find whether a particular area of research is on the rise, steady, or declining
- **Support strategic business planning**
STN software helps understand and interpret search results

- **STN® Viewer™** provides an exciting new way to review the full-text of the results of a patent file search on STN
- **STN Express®** provides post-processing table and report options, and ANALYZE plus *Wizard* with data grouping
- **STN® AnaVist™** provides a research landscape and multiple interactive charts
STN AnaVist, Version 2.0: an advanced tool for collecting & analyzing answers from STN files

- STN AnaVist automatically creates interactive visualizations that are dynamically linked
  - 1-dimensional Bar Charts
  - 2-dimensional Matrix Charts
  - Research Landscape
- Evaluate unique relationships between structured and unstructured data, make data comparisons
- Integrated content from multiple files
  - CAplusSM family of files, Derwent World Patents Index® (DWPISM), PCTFULL, and U.S. full-text patent files
- Includes project sharing, reporting, and exporting features
New features for STN AnaVist, Version 2.0

- Addition of the Derwent World Patents Index
  - Analyze by DWPI Classification and Manual Codes
- Custom visualization fields – text mining
- Highlighting manager – allows you to more easily make comparisons and determine trends
- Document Labels – customized categorization
STN AnaVist, Version 2.0 takes customized analysis to a new level

Use Version 2.0’s highlighting capabilities to assign different colors to concepts enabling easier comparisons and visualization of trends.
Getting Started with STN AnaVist 2.0

• STN AnaVist 2.0 software - FREE
  – Available from the STN Software License and Download Web site

• STN Express, Version 8.3 – FREE
  – Available from the STN Software License and Download Web site

• Visit
Agenda

• Getting started with STN AnaVist 2.0
• Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0
• A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0
• Project sharing and pricing structure
What does DWPI bring to STN AnaVist 2.0?

• Enhanced patent titles and abstracts
  – Reduction in time required to assess results
  – High relevance for concept clustering
• Intellectually compiled patent families
  – Precise analysis by “invention” count
  – Reduced duplication (equivalents) in results
• Thomson classification and indexing
  – Flexible and precise subject segmentation
  – Simple exclusion/inclusion of technologies
Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0

Analysis and visualization question:
Who are the major players, and what are the key research trends in the area of exhaust gas particulate filters for diesel engines?
Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0

• Save for STN AnaVist Wizard in STN Express
• Import and Visualization process
• DWPI database content in STN AnaVist 2.0
• Bar/Matrix chart creation, editing, and use
• Navigation of the Research Landscape
• Highlighting and Labeling
• Managing Documents
• Exporting, Reporting, and Sharing Projects
Use STN Express 8.3+ for creating a superior document set for STN AnaVist 2.0

• Use advanced STN commands to control imported records
  – TRANSFER
  – DUPLICATE REMOVE/IDENTIFY
  – FSORT/FSEARCH

• Supported STN databases
  – CAplus, USPATFULL, USPAT2, PCTFULL
  – WPINDEX, WPIDS, and WPIX
Use STN Express 8.3+ for creating a superior document set for STN AnaVist 2.0 (cont.)

=> FILE WPINDEX

=> SET SFIELDS BI CLM
SET COMMAND COMPLETED

=> SET PLURALS ON
SET COMMAND COMPLETED

To include DWPI claim text in your search, use the SET SFIELDS BI CLM command.

=> S DIESEL(4A) FILTER(5A) (SOOT OR PARTIC?)
L1  2099 DIESEL/BI,CLM(4A)FILTER/BI,CLM(5A) (SOOT/BI,CLM OR PARTIC? /BI,CLM)

=> S DIESEL(5A) (CATALYST OR PARTIC? FILTER OR REDUC?(2A) POLLUT? OR (PURIFY? OR CLEAN?))(2A) EXHAUST)
L2  3501 DIESEL/BI,CLM(5A) (CATALYST/BI,CLM OR PARTIC? FILTER/BI,CLM OR REDUC?/BI,CLM(2A)POLLUT?/BI,CLM OR (PURIFY?/BI,CLM OR CLEAN?/BI,CLM) (2A)EXHAUST/BI,CLM)

=> S L1 OR L2
L3  3997 L1 OR L2
Reminder: the DWPI default Basic Index (/BI) is formed from value-added text fields.

- **basic index (/BI)**
- **basic index extension (/BIEX)**

The basic index (/BI) includes:

- **Title, Abstract**
- **Main Claim (/CLM)**

The members part includes:

- **mission part**

The value-added text fields include:

- **AN 1999-265576**
- **PI EP913216 A1 CA2251524 A1 CN1219449 A**
- **MEMBER 1 EP913216 A1**
- **MEMBER 2 CA2251524 A1**
- **MEMBER 3 CN1219449 A**

...
Save for STN AnaVist 2.0 via the L-number, Select Discover! Wizard, or Discover! menu.

Three ways to save answers for STN AnaVist 2.0.
The Save for STN AnaVist Wizard prompts you for all the needed information. Select Save for STN AnaVist 2.0+. No cost to Save for STN AnaVist.
Launch, Login and import records from STN Express to STN AnaVist

1. Click "Import" to bring STN results into STN AnaVist environment
2. Review documents by DWPI title prior to visualization (optional)
3. Apply Cost Center (optional) and/or set STN AnaVist preferences under Tools menu
4. Visualize

STN AnaVist has no connect time, connection costs or subscription/annual fees.
STN AnaVist 2.0 allows modification of clustering fields for data and text mining components.

- Title/Abstract are the default clustering field.
- DWPI Exemplary Claim option also available.
- Backup clustering fields in cases where primary field is missing.
- Clustering by IPC codes by customer request.

Custom includes the option to cluster by DWPI Title/Abstract and Exemplary Claim.
STN AnaVist 2.0 allows modification of clustering fields for data and text mining components

- Following initiating a visualization, STN AnaVist 2.0 allows selection for the clustering fields to be used for the Research Landscape
  - Choices displayed depend on the source databases (e.g. DWPI, see previous slide)
- Use of Title/Abstract is the default – Clustering Concepts
- Individual or groups of other fields are available
- Backup fields are used only if other clustering fields are unavailable in a record

<table>
<thead>
<tr>
<th>Standard</th>
<th>Custom</th>
<th>Backup Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title/Abstract</td>
<td>Title/Abstract</td>
<td>Exemplary/First Claim</td>
</tr>
<tr>
<td>IPC Codes</td>
<td>Exemplary/First Claim</td>
<td>All Claims</td>
</tr>
<tr>
<td></td>
<td>Technology Indicators</td>
<td>Technology Indicators</td>
</tr>
<tr>
<td></td>
<td>IPC Codes</td>
<td></td>
</tr>
</tbody>
</table>
Following visualization completion, STN AnaVist displays a default set of windows. Additional charts may be created.

Default windows include:
- Key Inventors by Publication Year (matrix chart)
- Key Assignees
- Research Landscape
- Documents

Clicking on an assignee column highlights associated inventors, and DWPI records/documents.
Create a wide variety of bar and matrix charts to evaluate document relationships

STN AnaVist 2.0 enables the creation of 1-dimensional Bar Charts or 2-dimensional Matrix charts for 13 different types of data:

- Key Organizations/Assignees
- Key Researchers
- Publication Year Trends
- Clustering Concepts
- Patent Classifications
- DWPI Classification
- DWPI Manual Codes
- Patent Countries
- Patent Country Code/Kind Code
- Priority Application Dates
- Labels
- Technology Indicators
- Document Distribution

Interactive charts are linked dynamically, and reflect document counts across the STN AnaVist environment – including Research Landscape
Summary of DWPI database content available in STN AnaVist 2.0

• Bibliographic data
  – Inventors (IN), Patent Assignees (PA)
  – Publication Number (PN), Kind (PK), and Date (PD)
  – Priority Date First (PRDF)

• Value-added and original publication text
  – Enhanced Title (TI)
  – Enhanced Abstract (AB), Technology Focus (TECH)
  – Exemplary/First Claim in English (CLMEN)

• Patent classifications
  – DWPI Classification (DC), Manual Codes (MC)
  – International Patent Classification (IPC)
Create interactive bar charts from any or all of the available 13 data mining fields

- Bar charts reflect document counts and highlighted document counts
  - Hover over any bar to reveal document numbers
- Increase or decrease data in window using magnifying glass controls
- Choose to display highlighted bars only to remove excess data points
- Bar charts may be displayed vertically or horizontally
Customize sorting of bar chart displays for improved evaluation

- Sort bar charts ascending or descending by
  - Document Count
  - Highlighted Count
  - Label
  - Highlight Set Position
  - Unhighlighted Count

Access sorting options via the floating toolbar or chart properties.
Create matrix charts from any or all of the available 13 data mining fields

- Matrix charts are interactive cross-tabulations that show document co-occurrence counts
  - 7/283 indicates that 7 out of a total of 283 documents with *remove* and *nitrogen* as clustering concepts are currently highlighted elsewhere in STN AnaVist

- Terms in matrix charts may be grouped and edited as elsewhere in STN AnaVist

- As shown here, it is possible to create self-referencing Matrix charts, such as classifications or assignee assignments

<table>
<thead>
<tr>
<th>Clustering Concepts by Clustering Concepts - ©</th>
</tr>
</thead>
<tbody>
<tr>
<td>remove</td>
</tr>
<tr>
<td>remove</td>
</tr>
<tr>
<td>vehicle</td>
</tr>
<tr>
<td>mater</td>
</tr>
<tr>
<td>device</td>
</tr>
<tr>
<td>pressur</td>
</tr>
<tr>
<td>operate</td>
</tr>
<tr>
<td>nitrogen</td>
</tr>
<tr>
<td>ceramic</td>
</tr>
<tr>
<td>surface</td>
</tr>
<tr>
<td>grow</td>
</tr>
<tr>
<td>structure</td>
</tr>
<tr>
<td>soot</td>
</tr>
<tr>
<td>air</td>
</tr>
<tr>
<td>side</td>
</tr>
<tr>
<td>emission</td>
</tr>
</tbody>
</table>
Similar sorting options are available for matrix charts via the chart properties window or sort button.

- Sort matrix charts ascending or descending by:
  - Document Count
  - Highlighted Count
  - Label
STN AnaVist 2.0 allows term editing for all 13 data fields to improve statistical relevance of charts

- Right-click in any chart to access term editing, or click the Edit Terms icon in the floating toolbar
- Show Split Pane for easier evaluation of terms across the Term Editor
- Group similar terms together (folders), or exclude terms from evaluation (italics)
- Save grouping for future results

Note: Term editing Clustering Concepts changes both charts and the Research Landscape.
In particular, it's worth editing Terms for Patent Assignees as this will improve your analysis.

Save assignee groupings for use with future results.
Use right-click to drill-down to documents of interest from within any STN AnaVist chart.

Here we drill-down to retrieve the 10 records in which Denso Corp. is a co-assignee with Toyota Motor Corp.
The Research Landscape assists in document organization and project understanding

• The Research Landscape is the "big picture" of your document answer set, enabling you to identify areas and patterns for further exploration within STN AnaVist

• In the Research Landscape
  – Each document is represented by a dot on the chart
  – Documents that are thematically similar are closer to one another on the chart, and documents that are less similar are farther away from one another
  – The density of the documents in a particular area is extrapolated into a peak height value

• The Research Landscape is interactive with the rest of the STN AnaVist visualization workspace

• Editing of Clustering Concepts changes the Landscape

• Landscape annotation and alternate views are available
A host of tools provide customization and navigation of the Research Landscape

Landscape Navigator

Contour Lines

Label

Document Points

Landscape Cursors

Edit Terms

Landscape View

Tip: Nearly all Research Landscape features available by Right-click.
Annotate the Research Landscape for more meaningful personalized labels of document peaks

- Document peak labels describe most commonly occurring terms – not necessarily indicative of research front
- Right-click within the window to begin to "Add Annotation"
- Annotations may be moved and/or deleted

**Tip:** Contour lines can also be added for further clarity.
The Highlight Manager allows you to explore multiple relationships between records and data

- With the STN AnaVist Highlight Manager, you can use multiple colors to compare as many as eight sets of documents and their relationships

- To use the Highlight Manager, click the Highlight Color Selector (__) and select Highlight Manager
Highlight colors exist throughout the STN AnaVist environment, including in bar / matrix charts.

Evaluating by publication year, to determine if new technologies are emerging and by whom.
Labels allow personalized flagging of unique documents for future retrieval or refinement

• You can use labels to identify a group of documents within a visualized answer set
• Labeling is especially useful for creating document subsets for subsequent saving, printing, or sharing
• Right-click or use the Tools menu to Apply Labels, from charts, matrix charts, or the Document Manager
STN AnaVist 2.0 provides options for displaying record information

• You have three options for viewing document details
  – View details in STN AnaVist
  – View details in STN via STN Express, Version 8.3
  – Obtaining original documents via the ChemPort® Connection™

• STN AnaVist 2.0 provides access to document data in a “condensed” format for quick and convenient display

• You can display details for a document by clicking a title either before or after a visualization
STN AnaVist 2.0 Documents Manager offers a number of save, display, label, and filter options.

<table>
<thead>
<tr>
<th>Save/Print</th>
<th>Add Labels</th>
<th>Highlighted / Unhighlighted</th>
<th>Filter by Highlight Manager</th>
</tr>
</thead>
</table>

**Select Records**

**Highlight Data**

**Display Records**

**Label Data**

<table>
<thead>
<tr>
<th>Title</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugged honeycomb structure production for diesel particulate filter, involves filling ceramic slurry into cells of honeycomb structure, by pressing end face of honeycomb structure against leveled slurry on belt surface. WPINDEX</td>
<td></td>
</tr>
<tr>
<td>Filter used as diesel engine exhaust filter comprises ceramic structure having gas inlet and outlet channels disposed between gas inlet and outlet end; and a catalyst in the form of coating that is distributed within ceramic walls. WPINDEX</td>
<td></td>
</tr>
<tr>
<td>Ceramic filter production for filtering, e.g. liquid effluents, involves providing perforated film at each side of honeycomb material, and introducing closing material in open channel by aspiration across perforations of film. WPINDEX</td>
<td></td>
</tr>
<tr>
<td>Gas sensor e.g. soot sensor, unit for motor vehicle, has temperature measuring unit with resistance strip conductor having lower electrical resistance, where unit has two measuring electrodes that are designed as interdigital electrodes. WPINDEX</td>
<td></td>
</tr>
<tr>
<td>Ceramic bonding composition for diesel particulate filter comprises specific amount of ceramic particles, inorganic binder, liquid medium, and hollow particles. WPINDEX</td>
<td></td>
</tr>
<tr>
<td>Ceramic honeycomb filter for filtering particulate soot from exhaust streams of diesel engines, comprises ceramic material having very small amount of small pores which are formed by the former, e.g. canna starch. WPINDEX</td>
<td></td>
</tr>
</tbody>
</table>
Save records from the Documents Manager to PDF or Rich Text Format, or for display in STN Express.

Use the saved XTA file with STN Express “Display from STN AnaVist Wizard” or the “Create L# from STN AnaVist Wizard”. No cost to create .xta file.
Use the Display from STN AnaVist Wizard to display documents in your choice of STN format. Use the saved XTA file with STN Express "Display from STN AnaVist Wizard". No cost to create .xta file.
Use the **Create L# from STN AnaVist Wizard** to create an standard L-number answer set on STN.

Use the saved XTA file with STN Express “Create L# from STN AnaVist Wizard”. No cost to create .xta file.
Generate Summary and Detailed Reports via the File menu, or by Right-clicking on a project name.

Here the detailed report in PDF format is shown.
Agenda

- Getting started with STN AnaVist 2.0
- Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0
- A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0
- Project sharing and pricing structure
A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0

Analysis and visualization question:
In December 2006, Bayer AG acquired Schering AG. Bayer Schering AG was formed. How well did the technologies of these two companies line up? Did Bayer mostly pick up IP in areas it was already working in? Where there any Schering technologies that represent opportunities for Bayer AG to pursue? Or potential for spin offs?
Typical Steps in the creation of a STN AnaVist 2.0 project

I. Save STN Express answers for STN AnaVist
II. Import saved answers from STN Express
III. Visualize records within STN AnaVist 2.0
IV. Preliminary assessment of your project
   – Evaluate bar/matrix charts/Research Landscape
V. Edit terms – for data and text mining
VI. Annotate the Research Landscape
VII. Creating subset visualizations
VIII. Save data/charts, reporting, project sharing
Save STN Express answers for visualization in STN AnaVist

=> FILE WPINDEX

=> SET EXPAND CONTINUOUS
SET COMMAND COMPLETED

=> E BAYER AG+ALL/PACO
E1 0 --> BAYER AG/PACO
E2 31771 CODE FARB-C/PACO
*********** END ***********

=> E SCHERING AG+ALL/PACO
E3 0 --> SCHERING AG/PACO
E4 3804 CODE SCHD-C/PACO
*********** END ***********

=> S E2 OR E4
31771 FARB-C/PACO
3804 SCHD-C/PACO
L1 35494 FARB-C/PACO OR SCHD-C/PACO

=> S L1 AND PY.B>1995
8318123 PY.B>1995
L2 10701 L1 AND PY.B>1995

Save for STN AnaVist 2.0 via the L-number, Select Discover! Wizard, or Discover! menu (see slides 16-17).

Here we are using the DWPI Patent Assignee Code (PACO) to retrieve our assignee-based answer set.

In L2, we have focused the search to basic publications from the decade prior to the merger (PY.B > 1995).
Launch, login and import answers from STN Express to STN AnaVist

1. Click "Import" to bring STN results into STN AnaVist environment
2. Review documents by DWPI title prior to visualization (optional)
3. Apply Cost Center (optional) and/or set STN AnaVist preferences under Tools menu
4. Visualize
STN AnaVist 2.0 allows modification of clustering fields for data and text mining components.

- Title/Abstract are the default clustering field.
- DWPI Exemplary Claim option also available.
- Backup clustering fields in cases where primary field is missing.
- Clustering by IPC codes by customer request.

Custom includes the option to cluster by DWPI Title/Abstract and Exemplary Claim.
STN AnaVist 2.0 allows modification of clustering fields for data and text mining components (cont.).

Select the custom clustering fields to create a Research Landscape based on a combination of text fields or based on IPC codes.
As before, following visualization completion, STN AnaVist displays a default set of windows. Clicking on an assignee column highlights associated inventors, DWPI documents, and distribution over the Research Landscape.
The Research Landscape is created by text-mining terms selected at visualization creation

1. Significant keywords (clustering concepts) are derived from the clustering options selected for the visualization, these keywords are used to determine the similarity between documents

2. An algorithm uses document similarity scores to position documents relative to one another in a two-dimensional (x, y coordinate) space, with each document positioned at one point

3. A map is generated, the height of each "peak" on the map correlates to the density of the documents in an area

4. Special considerations apply to visualizations based on IPC codes (more on that later)
The clustering choices available to you depend on the content of the data set you are visualizing.

<table>
<thead>
<tr>
<th>Clustering Field (availability)</th>
<th>CAplus</th>
<th>PCTFULL</th>
<th>USPATFULL/USPAT2</th>
<th>WPINDEX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title/Abstract</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Exemplary/First Claim</td>
<td>N</td>
<td>Some</td>
<td>Y</td>
<td>Some</td>
</tr>
<tr>
<td>All Claims</td>
<td>N</td>
<td>Some</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Technology Indicators</td>
<td>Y</td>
<td>N</td>
<td>Some</td>
<td>N</td>
</tr>
<tr>
<td>IPC Codes</td>
<td>Some</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

- Certain documents within your data set may not have the clustering field(s) you select, for those documents, you also may choose one or more backup fields.
- Your clustering fields choice is permanent for a particular project and any subset visualizations created from it.
The Research Landscape can be customized by adjusting Concept Frequency prior to visualization.

- Adjust the Concept Frequency for your project in the Preferences
  - Minimum: 10%, Default: 25%, Maximum: 70%

**Tip:** To try a different Concept Frequency, change your Concept Frequency setting, select your entire Research Landscape, and then perform a no-cost subset visualization.

Note: Adjusting the Concept Frequency does not affect IPC code visualizations, which always use a Concept Frequency of 100%.
The Research Landscape can also be customized after visualization by term editing to manually exclude selected concepts

- Right-click in any chart to access term editing, or click the Edit Terms icon in the floating toolbar
- Group similar terms together (folders), or exclude terms from evaluation (italics)
- Show Split Pane for easier grouping of terms across the Term Editor
- Option: save grouping for future results

Term editing clustering concepts changes both the Research Landscape and relevant charts.
Clustering concept term editing alters distribution of documents within the Research Landscape

Every project requires different term editing.

Tip: Gradually group/ungroup and exclude/include terms until desired document distribution is achieved.
DWPI Classification (DC) and Manual Code (MC) charts and matrix charts can easily be added.

DWPI DC and MC charts may be added.
DWPI Classes (DC), Manual Codes (MC), and File Segments (FS) flowchart

All Patents

- Chemical CPI
  - Sections A-M
    - DC and MC

- Mechanical EngPI
  - Sections P-Q
    - DC and MC

- Electrical & Electronic EPI
  - Sections S-X
    - DC and MC
DWPI Classification is a broad system assigned by Thomson uniquely to DWPI

- Assigned to the principal claimed novelty and/or use of the invention
- Searchable by all users of DWPI on STN at two levels: section and class
  - Section: => S B/DC
  - Class: => S B01/DC
- Typically used for improving the relevance of otherwise ambiguous search terms
  - E.g. => S ABS AND Q18/DC (Brake Control)
- There are 21 Sections (A-M, P-Q, S-X)
DWPI Manual Codes are an in-depth system assigned by Thomson uniquely to DWPI

• Unlike other classifications, MCs are assigned to the invention’s novelty and to its use/application
  – MCs are therefore ideal tools for patent analysis

• MCs are assigned to basic patents in chemical/life science and in engineering
  – The engineering codes (S-X, Q) are searchable by all users of DWPI on STN
  – Chemical/life science codes (A-N) can only be searched by Subscribers (WPIDS/WPIX)

• MCs are available to all users of STN AnaVist 2.0 for analysis and visualization
In context DWPI classification (DC) and Manual Code (MC) definitions are available.

Use the right mouse click, and select “Label Description” to get the DC or MC definition.

- **D16:** Fermentation industry
- **D11:** Baking, baking prod., not flour milling
- **D12:** Treatment/processing of meat, poultry and fish
- **D13:** Other foods/food treatment incl. additives
- **D14:** General foodstuffs machinery
- **D15:** Treating water, industrial waste and sewage
Use the Term Editor Autogroup function to chart by DWPI classification section letter

B = Pharmaceutical
A = Polymer Technology
DWPI Chemical (CPI) classification sections

A Polymers & plastics
B Pharmaceuticals
C Agrochemicals
D Food, detergents, water treatment, biotechnology
E General chemicals
F Textiles & paper
G Printing, coating, & photographic
H Petroleum
J Chemical engineering
K Nucleonics, explosives & protection
L Refractories, glass, ceramics cement, & electro(in)organics
M Metallurgy
DWPI Engineering classification sections

• Mechanical (EngPI)
  P  Miscellaneous
  Q  Mechanical engineering

• Electrical/Electronic (EPI)
  S  Instrumentation; Measuring and testing
  T  Computing and Control
  U  Semiconductors and electronic circuitry
  V  Electronic components
  W  Communications
  X  Electric power engineering
When using STN AnaVist, keep in mind the history of DWPI Classes (DC) and Manual Codes (MC)

1963- **B**: Pharmaceuticals
1965- **C**: Agrochemicals/Veterinary
1966- **A**: Polymer science
1970- **A-M**: All chemistry
1974- **S-X**: Electrical/Electronic (DC only)
1974- **P&Q**: Mechanical (DC only)
1977- **N**: Catalysts (MC only)
1980- **S-X**: Manual Codes introduced
2005- **Q**: Manual Codes introduced*

(* There are no Manual Codes for Section P.*)
DWPI classification section shows clearly each company’s broad technology areas.

Unlike Schering, Bayer has a large proportion of polymer technology inventions. A subset visualization of pharmaceutical (B) documents may help in our analysis.
DWPI classification can also help bring insight to our review of the Research Landscape.

On our landscape:
- The polymer (A) inventions are highlighted towards the bottom and left.
- The pharmaceutical (B) inventions are grouped on the top and right.

The pink documents in the middle are those which are classified in A and B.

A subset visualization of pharmaceutical (B), may well help in our analysis.
Use subset visualizations to extend the value of your visualization project

- To create a subset visualization, select a portion (or all) of the data, e.g. DWPI Section B, and click the button

- A subset visualization is created from the active highlighting set – AnaVist indicates which one (above)
- Subset visualizations do not retain term groupings/exclusions, highlighting, and labels from the project
- A subset visualization can use a different concept frequency than the project from which it was derived
- There is no charge to create a subset visualization
The DWPI section B subset visualization makes the company comparison clearer. Schering AG appears to have had many patents in an area that Bayer AG did not: IPC C07J and DC B01 (Steroids).
Use the Term Editor Autogroup function to adjust the depth of a Manual Code analysis.

B14-H01 = Anti-cancer
B12-K04 = Diagnostics
The DWPI section B subset visualization has also provided a more meaningful research landscape.

- Areas of technology overlap exist, e.g. breast cancer therapies and diagnostic processes
- Some key areas of technology which are unique to Schering stand out clearly (circled in black)
- Annotations make the key areas of uniqueness even clearer for sharing with your colleagues
Project sharing leverages your intellectual investment by allowing your colleagues to profit from and interact with your work

- Projects created in Version 2.0 (using the .shx format) can be shared with colleagues in your organization
- Sharing creates a copy of your existing project, including all annotations, charts and the Research Landscape
- Recipients of the shared project must have either a full STN Login ID or an STN AnaVist Shared Login ID
- Recipients may customize their copy of a shared project
- No additional visualization costs for project sharing - storage fees and document display charges may apply
Save an STN AnaVist 2.0 Project Copy via the File menu – Save Copy of “…”
Open an STN AnaVist 2.0 Project Copy via the File menu – Open Project Copy
Shared Login IDs allow non-STN users access to shared visualization projects

- STN AnaVist Login IDs for Shared Projects allow individuals in your organization to gain access to STN AnaVist shared projects
  - Shared Login IDs cannot create new visualizations
- To request Shared Login IDs, complete the STN Login ID for Shared Projects Request Form
  [www.cas.org/products/anavist/howtolicense.html](http://www.cas.org/products/anavist/howtolicense.html)
- Any fees incurred by Shared Login IDs are billed to the associated full-access STN account
Review: Typical Steps in the creation of a STN AnaVist 2.0 project

I. Save STN Express answers for STN AnaVist
II. Import saved answers from STN Express
III. Visualize records within STN AnaVist 2.0
IV. Preliminary assessment of your project
   – Evaluate bar / matrix charts / Research Landscape
V. Edit terms – for data and text mining
VI. Annotate the Research Landscape
VII. Creating subset visualizations
VIII. Save data/charts, reporting, project sharing
Agenda

- Introduction to STN AnaVist 2.0
- Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0
- A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0
- Pricing structure and resources
The pricing structure of STN AnaVist is straightforward

- No cost to use Save for STN AnaVist Wizard
- No cost to import documents from STN Express
- No annual fees, subscriptions, or software costs
- No pre-purchase of data
- One-time tiered fees for the actual analysis; includes the ability to create subset visualizations for no additional charge
- Document display fees – consistent with STN
Resources for DWPI in STN AnaVist 2.0

- STN AnaVist 2.0 web pages
  [www.cas.org/support/stna/](http://www.cas.org/support/stna/)
  - Recorded Tutorials, Quick Start Guides
  - *See How It Works* for specific features
- DWPI Classification and Manual Codes
  - Look-Up Tool and User Guides
- CAS e-Seminar archives
  [https://casevents.webex.com/](https://casevents.webex.com/)
  - Introduction to STN AnaVist 2.0
  - Use of STN AnaVist 2.0
  - Creating superior document sets for STN AnaVist 2.0
Review

• Getting started with STN AnaVist 2.0
• Step-by-step tour through the features and benefits of DWPI in STN AnaVist 2.0
• A simple competitive intelligence case study, using DWPI in STN AnaVist 2.0
• Project sharing and pricing structure
Acknowledgements

- Matt McBride (CAS)
  mmcbride@cas.org

- Brian Sweet (CAS)
  bsweet@cas.org
Exploring Derwent World Patents Index® in STN® AnaVist™, Version 2.0

www.stn-international.com